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1. Introduction

Extelis an electronic spreadsheet, which may be used to organize data, petform calculations, create charts and
for many other putposes. Graphics, tables and chatts created by Exve/ can be pasted into word processots
such as Word ot WordPerfect, and thus be included in essays and reports.

Exzelis a valuable tool in statistics, science and business. Statisticians use it to create histograms and scatter
plots, calculate basic statistics, construct confidence intervals and carty out hypothesis testing and regression
analysis. In science and business, it is used to manipulate data and plot data, and to find best-fit
approximations.

Note: to perform the examples and exercises in the manual at the college, you will need a floppy
disk on which to store your work.
1.1 Starting Excel

First run Windows. How you then open Exze/ depends on your system. Here are some possibilities:
*  Look for an Exce/ shortcut (see below) , possibly on a taskbat, at the top of the screen.

Figure 1

* Ifyou findit, click on it.
*  Otherwise click on Start, Programs and look for Exvel. Click on it.

Note that the object (file) created by Exce/is a workbook, which is organized into worksheets, as a book is
made up of pages. You can view the different sheets by clicking on the tabs (Sheez 7, Sheet 2, etc.) above the
status bar, at the bottom of the screen.

A sample worksheet is shown on the next page. The sheet contains several bars at the top. The first one is
the 7t/ bar, which reads “Microsoft Excel”. Below that is the menu bar, followed by the standard toolbar, and the
Jormala bar. At the bottom is the status bar, which should read ‘Ready”. Between these is the workbook window
with a new workbook.

A worksheet consists of cells; each one referred to by a column letter and a row number. The cutrently
selected cell (A1) is highlighted by a black outline and its reference appears in the zame box at the left of the
Jformula bar. The contents of this cell appear in the formula box to the right of the name box.
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Figure 2: an Excel Worksheet

1.2 Saving a File

As you may work on a workbook over a period of time, you will want to be able to save it as a file on a floppy,
and later re-open it for further work. Should you be working on your own computer, you may wish to ignore
the references to floppies and the .4: drive and save files on the C: hard drive.

Files may be saved using Save or Save as, which may be found by clicking on Fik, in the Menx bar. If a file
already has a name, having been opened from a floppy in the A drive, Save will save it under that name on
that drive, overwriting the original version. Thus once a file has been created and saved on a floppy, you may
Open it from the floppy to wotk on it and then use Saze to update the floppy. Save as may be used if you wish
to save a file without destroying an eatlier version.

To Save
¢ Pull down the Fi/k menu and select Saze, or click on the Save icon on the standard toolbar. 1f the file

has been loaded from a floppy, no further action is required. If the file is new, the Save as dialog box
will open and the steps are as for Saze as below.



To Save as:
*  Pull down the Fz/e menu and select Save as. The Save as dialogue box will open.
*  Be sute drive A is chosen and that you have a formatted disk in drive A.
*  Delete what is in the Fil name box, and replace by a name of your choosing, such as zyproject.
*  In the Save as fype box be sure that Microsoft Excel Notebook is chosen. Exce/ will automatically add the

extension xr to the file name so that it will be saved as myproject. x5, for example.
*  Now click the Sare button.

1.3 Opening a File
Opening a file loads a worksheet from your floppy and creates an Exve/ workbook.
*  Click on Fil, then Open, or click on the Open icon on the standard toolbar. Specify the name of the file
in the dialog box and then click on Oper. You may need to change the directory in the Look in box

to find your file. If the file is on a floppy, place it drive A. Select drive A at the top of the dialogue
box and then click on the file you want.

1.4 Exiting Excel
To quit using Esel

*  Click on Exit under the File menu, or on the cross at the top right corner of the Exve/ window. If
you have not saved the workbook since you last made changes, Exve/ will prompt you to save it.

1.5 Selecting a Region
In order to copy-and-paste, and perhaps print, you must be able to select from the worksheet.

To select a cell:
*  (Click on it.

To select a row ot column:
*  Click on the number or letter that labels it. These are located on the row above the worksheet or the
column to the left of it.
To select a rectangular region:
*  Place the cursor in one corner, press and hold down [§4#]. Click in the opposite corner and release
Shift. The region should be highlighted.
Alternatively:
*  Place the cursor in one corner of the region. Press the left mouse button and hold it down.

*  Drag the cursor to the opposite corner and release.

To select a plot:
¢ Click on the plot.



1.6 Printing Work

You may never wish to print a worksheet, in whole or in patt, as it is usual to copy selections into reports that
are produced by a word processor. If, however, you do wish to do so, here are the steps:

Open the Fi/z menu and select Print Preview to see how your file will appear when printed. (This will
not work if your worksheet is blank.)

If you are happy with its appearance, choose Print from the File menu. Check the details in the
dialog box, edit these, if necessary, and then click Prinz. (If you are working in a lab, you may have
to ask the technician for help in determining which computer to use and where the document will
be printed.)

If you are not happy with the appearance of your document you can open the Page Ser Up dialog box
from the Fz/e menu and make changes in the appearances of your document. You may wish to
check the Excel reference for help with this.

1.7 Copying to a Word Processor

You can copy chatts, graphs, tables or other patts of your workbook to a word processor such as Word or
WordPerfect. To do so you must run the two applications, Exve/and the word processor, in sepatrate windows.

Open one of the applications as usual and open the appropriate file.
Open the second application and open the approptiate file.

You should now see the names of the applications at the bottom of the screen. Clicking on one will
allow you to wotk on it. Thus, at a gtven time, you may choose which application you wish to use.

To copy from Excet

In the workbook, click on the worksheet containing the chart, table or graph you wish to copy.
Select the region or plot.

Copy either by choosing Copy from the Edit menu or by clicking on the Copy icon on the standard
toolbar.

Switch to the word processor. Move the text cursor to the point whete you want the chart, table or
graph to be placed.

Paste either by choosing Paste from the Edsit menu, or the paste icon from the standard toolbar.

Pasted images may be edited for size and position using the usual word processor tools.



1.8 References and Help

Excel has several useful avenues for getting help:

Help menu:

*  Choose Contents and Index to search the Help files, or click on What’s this? from the Help Menu.
Tool Tips:

*  When the mouse is placed over a button on the tool bar and left there for a short time, its name appeats.
This helps in using the Help Menu.

Screen Tips:
*  Click on the question mark sign that appears in the top-right corner of most dialog boxes.
You should look for Excel references in two places, the computer labs and on resetve in the library.

The lab technician or tutor may be able to help with some problems. You may also ask your instructor for
help.






2. Entering and Naming Data

The following example shows how to enter and label data.
Example 1
A college advisor wishes to study the relationship between incoming students’ high school averages (HSA’s)

and their first semester college grade point averages (GPA’s). A sample of 10 students is obtained and their
HSA’s and GPA’s ate tecotded, in the following table.

HSA 70 1 75 | 78 | 80 [ 8 | 82 | 72 | 65 | 68 | 75

GPA |24 128 |33 |31 |37 |30]25]23]|28] 31

Fot convenience, this table has been printed horizontally. In Exre/, however, it is usual to enter data
vertically, so that the data corresponding to a variable appear as a column, rather than as a row.

2.1 Entering Data
To enter data you must select a cell and then type in the number. For the above data:
*  Open a new workbook.
*  Type HSA in cell Al. (Exce/ may well correct your spelling to HAS. You will need to tuth off the
automatic spell checker. Under the Took menu, pick .4utoCorrect and remove the checkmark beside
Replace text as you type.) Note that as you type, the lettets appear in both the cell and the formula box
on the formula bat. Press [Enfer] and the highlight moves to cell A2.
*  Type70. Press [Enter.

*  Continue down that column, entering 75, 78, etc.

*  When you get to the bottom use the arrow keys or the mouse to move the cursot to B1. First enter
the name GPA and then moving down the column enter the data 2.4, 2.8, etc.

Save this workbook for later use.
2.2 Entering Formulas

You may specify the value of a cell by a formula that depends on the values in othet cells. You can, for
example, define a cell to be the mean (average) of a range of cells. To enter a formula:

*  Type the equals sign (=) followed by the formula.



For example, to find the average of the first four HSA’s and put the result in cell D2, select cell D2 and type
=(A2+A3+A4+A5)/4 and press [Enter]. The cell should now display 75.75.

Excel has many built in functions which can make it easier to enter complicated formulas. For example, if
you type =AVERAGE(A2:A5) into cell D3, you will get the same result as in D2.

There is a glossaty of commonly used statistics functions in appendix 2.
2.3 Editing Cells

To replace the contents of a cell:

*  Move the cursor to the cell you want to replace and click. If you type anything now, the cutrent
contents will be erased and the new typing will replace it.

For example, if you want D2 to show the number of data in the second column, select D2 and type
=COUNT(B2:B11) After you press [Enter] you should see the result 10.

To edit the contents of a cell:

*  Select the cell and press the key F2. This will display the formula which you can now edit.

For example, if you want D3 to be the mean of all the HSA’s, select the cell, press F2, and change the 5 in the
formula to 11 and press [Enter]. The result should be 75.

2.4 Naming Cells

Naming cells or a group of cells makes it easier to refer to them in formulas and dialogue boxes. To make
the label HSA at the top of the first column a name for the data in that column:

¢ Select the cells from A1 to All
¢ From the Insert menu, click on Name, then Define. 1f the first box under Names in Workbook contains
the name you want, click OK. If it is blank, the name already exists, and you can either use a
different name, or edit the list of existing names. When done, press OK.
Do this for both HSA and GPA

You can now refer to each column by name. For example to find the standard deviation of the HSA data,
select cell D4 and type =STDEV(HSA) and press [Enter]. You should see 6.377042.

2.5 Inserting and Deleting Rows/Columns

To insert a row between existing rows:

*  Place the cursor in the row below where the new row should go. Choose Inserz from the menu bar
and then Rozs.

Named cells or ranges are adjusted to allow for the new row.



To insett a column between existing columns:

*  Place the cursor in the column to the right of where the new column should go. Choose Insert from
the menu bar and then Columzns.

To delete a row ot column:

*  Place the cursor in any cell of the row or column. Choose Edif from the menu bar, then Delete and
in the dialogue box check Entire Row or Entire Column and click Ok.

2.6 Formatting Entries

If the entty in a cell does not completely display because it is too long to fit, you may wish to make the
column widet o to use a smaller font.

To change column widths:

*  Move the cursor to the margin at the top of the worksheet that contains the letters identifying the
columns. Position it over a break between two columns. It will change its appeatance to a double
arrow with a vertical line. Hold down the left mouse button and drag the symbol to make the
column wider or narrower as you wish. If you double click, it will make the column wide enough
for all entties in that column.

To change the font or size:

e Select the cell or region you wish to format.

*  Under the Format menu, choose Cells and click on the appropriate tabs at the top of the dialogue
box that opens. Change the formatting as you wish.






3. Creating Histograms and Other Charts

3.1 Histograms

Example 2
Create 2 histogram for the high school grades from example 1.

If necessary, open the file from your floppy disk
3.1.1 Deciding on Classes

As the data is integet, the classes 65-69, 70-74, 75-79, 80-84 and 85-89 are suitable, using a class width of 5.
The first class has lower class boundaty at 64.5 and upper class boundary at 69.5. We will create a list of class
boundaties, in column D, as follows:

*  Put the first two class boundaries, 64.5 and 69.5, in D2 and D3

*  Rather than type the others (up to 89.5) we exploit Exve/’s ability to perform linear extrapolation to
take a list of two numbers and continue it so that the numbers are equally spaced. This saves time
fot large data sets and avoids arithmetic etrors.

Figure 3

*  Select these two cells. Put the cursor on the little square you see at the lower right corner of the
highlighted cells.

*  Drag downward with the mouse to D7 and let go. (Notice that as you drag a small yellow box
appears beside the cutsot, giving the latest number.) Now D2 to D7 should contain the class

boundaties we want.

Since these boundaries are upper class marks, type UCM into D1. (You may also wish to use this to name
the column.)

3.1.2 Creating a Histogram from Raw Data
*  Open the Tosks menu. If you see Data Analysis at the bottom, click on it.

*  Ifyou do not see Data Analysis, click on Add-ins and put a check beside Analysis Toolpak and click
OK



*  Now Data Analysis will appeat on the Tools menu. Click on it and then click on Histogram and OK. A
dialogue box will open.

(Note that dialogue boxes can be moved to a more convenient spot, by clicking on them and then dragging.)
»  Fillin the bozes as follows:
Input range: A1:A11  (This is the HSA data.)
Bin Range: D1:D7 (Exvel uses Bin Range to mean upper class boundaties.)

Output Range: A13  (This is a convenient location: Exve/ will place the output to the right
and below A13.)

Note that these ranges can be entered by first clicking on a box in the dialogue box and then selecting the
data using the mouse.

e Put a check beside Labels to indicate that the labels are included in the columns, otherwise Exce/ will
treat the labels as data and report an error.

*  Puta check beside Charz Ougput

Figure 4

*  Click OK This gives figure 5:

10
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Note that the Output Table (high-lighted in figure 5) gives the frequency disttibution. The first number in
each row is the upper class limit and the second is the number of data in that class. Thus the first row gives
the number of data less than or equal 64.5; the second row gives the data greater than 64.5 and less than ot
equal 69.5 and so on. Since thete is no data less than or equal 64.5, this class matk could have been omitted
from the list. However, it is a good idea to include it, as it acts as a safeguard in the event that you mistead
the table and mistake the lowest number. These classes can be removed, see below.

3.1.3 Modifying the Chart

It is usually necessary to edit a chart to improve its appearance. It is important to know that the Histogtam is
linked to the output table, but not to the original data. If you edit the data, nothing will happen unless you
trepeat the above procedure. If you edit the Output Table, it will immediately change the Histogtam. We can

exploit this by removing the first and last class, and by changing the remaining upper class marks to class
marks, so that the chart is correctly labelled.

3.1.4 Labelling the Classes

To change the labels to the class marks, we need to replace the upper class marks in the Output Table by the
class marks: 67, 72, ..., 87

*  Type 67 in A15 and 72 in A16, and then select and drag as we did before when creating the class
boundaries.

*  Delete the entries in the top and bottom rows of the Output Table, which have no data. (Don’t
delete the rows.) This simplifies the plot.

Yout Histogtam should now look like figure 6.

11
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3.1.5 Editing the Chart

The chart’s appearance should be further improved. To edit any patt of the plot, point to it with the cursor.
Its name will appear beside the cursor. Right clicking will then display a dialogue box that lets you edit that
object. Make the following changes.

*  The word Fregquency in the box at right is unnecessary. To remove it, click on it and press the [Delze]
key.

*  To make the plot taller, move the cutsor to the actual plot (so that you see the name Pt A4rea and
click on it. Then drag on the sizing handles that now surround the plot. If you are going to print in
black and white, you should remove the grey colour by right clicking on the Plz.Area, choose Format
Plor Area, and under Area choose None.

*  Ina Histogram, the bars should touch. To change the gap width, point the cutsor at a bar, and right
click. From the menu that appears, choose Format Data Series. Choose the Opiions tab and set the
Gap Width to 0. (If you want to change the colour or the fill pattern of the bars, choose the Patterns
tab.) When done, click OK.

*  Move the cursor to the hotizontal axis so that the name Catggory Axis appears. Right click and
choose Format Axis. Select the Scale tab and make sure that the box Value (Y) axis crosses between
categories is not checked. Click OK

*  Move the cursor to the grey part (so you see Plot Area). Right click and choose Format Plot Area.
For area, choose none. Click OK.

By now, your histogram should look like the following:

Histogram

----- & 72 7 82 8 -
ucM -

Figure 7
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To finish it off, you will need to edit the titles.

*  Click on the word Histogram so that a sizing box appeats around it, and then click on it again. You
should have a text cursor which allows you to backspace or edit as usual. Change the word

Histogram to High School Averages.

*  In the same way, change UCM to Student Averages (Vo) and freqaency to Number of Students.

Your final histogram should look like the following. You can cut and paste it into your wotd processot.

3.2 Pie Charts

Example 3.

High School Averages

Number of
Students
O - N Ww b

67

72 77 82

Student Averages (%)

57 -

Figure 8

A college has an annual budget of $8 million. This 1s spent as follows.

Faculty salaries

Staff salaries

Administration

Facilities Travel Misc

$4 000 000

$2 000 000

$700 000

$500 000 $300 000 $500 000

To draw a pie chart

*  Enter the data with the labels in column 1 and the amounts in column 2. Using units of $1 million
(so that $400 000 is given by 0.4) leads to simpler labelling.

Amount

4

2

0.7

0.5

0.3

0.5

Figure 9

*  Select both columns, including the top row.

13




*  Click on the Chart Wizard (Figure 10) on the Standard Toolbar and select Pre.

Figure 10
*  Select the type you want from the examples. Then click on Nex#>.
*  The next dialogue box confirms your choice of data. Click Nexz>.
*  Next you get the Charz Options dialogue box.
*  Click on the Tz tab, and type the title for the chatt in the Chart Titk box.
*  Click on the Iggend tab, and remove the check mark beside Show Legend.
*  Click on the Data Iabels tab and put a check mark beside Caregory Name.
Then click Nexz>.
*  Next you get the Chart Location dialogue box. If it is what you want, click on Finish.

Your final chart should look something like the one below:

College Budget ($millions)

Tra\reIMi

Facilities

Figure 11
3.2.1 Editing a Chart

A chart may not appear exactly as you want it. It can be edited in a similar manner to the way we edited
histograms.

3.2 Bar Charts
Bar charts can be constructed from frequency distributions tables.
Example 4

Construct a bar chart for the college budget in the previous example.

14



*  Asin the previous example, select both columns of data, and click on the Chart Wizard, but this
time select Column instead of Pie. Select the type you want - likely the top left one. Click Nex>.

*  The next dialogue box confitms your choice of data. Click Next>.

*  Next you get the Chart Options dialogue box.
*  Click on the Titl tab, and type the title for the chart in the Charz Title box.
*  Click on the Lggend tab, and remove the check mark beside Show Legend.
*  Click on the Data Labels tab and remove any checkmarks..
Then click Nexz>.

*  Next you get the Chart Location dialogue box. If it is what you want, click on Finish.

You can then edit as we did Histograms. The only difference is that we do not want the bars to touch. Your
final chart should look something like the following:

College Budget ($millions)

Faculty Staff

15






4. Descriptive Statistics

Once you have entered your data into a worksheet, there are several ways to calculate appropriate descriptive
statistics. One way is to enter the required formulas directly, another is to paste in the formulas using a
template, and another way is to use a built in package supplied by Exel.

Example 6. Use each way to find descriptive statistics for the HSA data of example 1.
4.1 Using built-in functions
*  Open the worksheet with the data from example 1

* Inaconvenient empty cell type the formula =AVERAGE(HSA) and press Enter. The mean should
be displayed in the cell. Itis a good idea to type “Mean” in the cell to the left.

*  In a similar way you can enter other functions such as COUNT(HSA) (Sample Size); STDEV(HSA)
(Standard Deviation), MEDIAN(HSA) (Median), MIN(HSA) (minimum), MAX(HSA) (Maximum),
QUARTILE(HSA,1) (fitst quartile).

4.2 Using a Template

A template is a section of wotksheet that contains the formulas needed for a particular calculation. In the
wotksheet statstemplates.xls (on the M drive in the computer labs) are a number of statistical templates. Each
template is in a box with a title at the top. After copying it into your worksheet you need to edit the formulas
in some of the cells to point to your data.

*  Open the worksheet with the data from example 1

*  Open the worksheet statszemplare.xls.

*  Click on the tab Miscellaneous. Select the entire box titled Basic Descriptive Statistics and copy it into
your wotksheet. Most of the formulas will display error messages.

70 2.4 Basic Descriptive Statistics
75 28
78 3.3 Data Summary
80 3.1 ni 0
85 37 mean} #DIV/OI
82 3 std deviation; #DIVO! |
72 25
BS 23 Five Number Summary
B8 2.8 minimum; 0
75 3.1 Qi #NUMI
median;  #NUMI
Q] #NUMI
maximum 0

16



*  Press Ciri-" (i.e. press the Ctr/key and the ™ (grave accent key at the top left of the keyboard) at the
same time. This will make the formulas visible.

Basic Descriptive Statist

Data Summary

ni=COUNT(datad)
mean=AYERAGE(datad)
std deviation:=STDEV(datad)

Five Number Summary
minimumi=MIN{(datad)
Qy=QUARTILE(datad,1)
mediani=MEDLAN(datad)
Q; i=QUARTILE(datad 3)
maxirmum :=MAX(datad)

*  Replace each instance of datad with HSA (your name for the HSA data). This can be done by
clicking on the cell, pressing F2 and editing as you edit any text. When done editing all cells, press
Ctrl-" again and you will see the results. You will need to adjust the widths of the columns for easy

readability.
70 2.4 {Basic Descriptive Statisti
7638
78 33 Data Summary
80 3.1 n 10]
85 37 mean 75
a2 3 std deviation 6.377042157
72 25
65 23 Five Number Summary
60 28 ini 65
75 3.1 Q 70.5
median 75
Q 79.5
i 85

4.3 Using Excel’s Built-in Package
Starting from your worksheet with the HSA data:

¢ From the Tools menu, choose Data Analysis. (If it does not appear on the Tools menu, click on A4dd-
ins and put a check beside Anapysis Toojpak and click OK)) Then choose Descriptive Statistics.

*  Enter the name HSA4 or A1:A11 in the input range box.
*  Put a check beside Iabels in First Row.
*  Toinsert the table into the current worksheet, click on the circle beside Ox#put Range and enter a

suitable cell in the box to the right. (You will need to allow for a table two columns wide and 15
rows deep.)

17



*  DPut a check beside Summary Statistics. The dialogue box will look like the figure below:

Descriptive Statistics

¢ Now click OK

You will probably have to adjust the column widths. Your table should look like the following:

HSA

78
Standard Error 2.016598
i 78
B 75
75| Standard Deviation | 6.377042
24 | Sample Variance | 40.66667
i -0.87875
-1.2E-16
20

b5

85

750

10

Do you know what all the entries mean? Look them up in your statistics textbook if necessaty.

While this method is straight forward, it does not give you the quartiles. To find these you will need to use
one of the first two methods.

18






5. Confidence Intervals For Means

Exel itself has no built-in method of finding confidence intervals. To do this you need to enter formulae as
necessaty, but this is time consuming and error prone. Itis better to use templates, which are sections of a
wortksheet containing the necessary formulae that can be copied into your worksheet. Linking these with
your data will give the required confidence intervals.

Example 7

Construct a 90% confidence interval for the GPA’s in example 1

As the population standard deviation is not known, we must use the 7 distribution template contained in the
statstemplates.xls wotkbook.

*  Open the wotkbook containing the data

*  Open statstemplates.xls, and find the Confidence Interval for Mean using t Distribution template. (It will be
on the worksheet titled Conf- 7 pop.) Select the template using the mouse.

e Select Copy from the Edit menu.

e Now switch to the wotkbook with the data. Choose a convenient place for the template and click
on the cell in the upper left corner.

*  Choose Paste from the Edit menu. Click and the template will appear in your wotrkbook.

Confidence Intenval for Mean

using t Distribution

Data Summary

n 0
Mean #DIVOI
StdDey #DIV/OI
User Input
Conf Level

Confidence Interval
Lower Limit #DIV/OI
Upper Limit #DIV/D!

The first column contains natmes, while the second column contains the corresponding formulas. For
example the formula beside # is =COUNT(datacm). When you first copy the template, these cells will display
etrot messages. “DIV/0P” means an illegal division by 0. This happens because datacm is not the name of
the data in your worksheet.
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To view and edit the formulas in the wotrksheet:

same time.

Press Cirl-" (i.e. press the C#/key and the * (grave accent key at the top left of the keyboard) at the

| for Mean
Data Si ¥ i
n:=COUNT(datacm)
Mean =AVERAGE(datacm)
StdDev:=STDEV(datacm)
User Input
Conf Level
L]

Replace each instance of datacm with GPA (your name for the GPA data). This can be done by
clicking on the cell, pressing F2 and editing as you edit any text. Enter the confidence level (0.90 for
90%) into the cell beside Conf Level.

®

Confidence Interval for Mean
using t Distributi

Data Summary

n:i=COUNT(GPA)
Mean:=AVERAGE(GPA)
StdDevi=STDEV(GPA)

User Input

Conf Level:0.9

When done, press Czr/-" again and you will see the results. You will need to adjust the widths of the
columns for easy readability.

Confidence Interval for Mean
using t Distribution
Data Summary
n 10
Mean 29
StdDevi 0.43204938
User Input
Conf Level 0.5
Confidence Interval
Lower Limit! 2.649548968
Upper Limit; 3.150451032
The 90% confidence interval for the

mean GPA is from 2.64 to 3.16.
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6. Hypothesis Testing of Mean of One Sample

The general procedure is:
*  Choose the appropriate test and copy the corresponding template to your wotkbook
*  If you have not already named the data, highlight it and choose Insers, Name, and Define.
*  Edit the formulas in the template to change databm into the name of your data.
*  Input your null hypothesis and .
Example 8.

Consider the GPA data from example 1. Test (at the 5% significance level) the claim that the mean GPA in
the population is greater than 2.5.

In this example, if i is the mean GPA in the population, we ate testing the hypotheses: H: p < 2.5 and
H;:p>25.

*  DPaste the appropriate template into your workbook.

Test for Mean

Data Summary

3

=COUNT(datahm)
Mean;=AVYERAGE(datahm)
StdDev;=STDEV(datahm)

{User Input

Hy Mean
Alpha

If you examine the formulas you will find that there are three that refer to the data, and two to the
hypotheses. Once these are fixed, the template will perform the calculations.

*  If necessary name the data GPA. Then click on the formula for #, press F2, and edit databm to read
GPA. Do this also for the formulas for mean and standard deviation.

Hyothesis Test for Mean

_____ Data Summary
n 10
Mean 2.9

_StdDev|=STDEV(datahm) | &
[ sTDEV{number1, [number2], ...)]

User Input
Hp Mean
Alpha
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Now choose Hy Mean and Alpha
* Enter 2.5 for Hy Mean and 0.05 for .Aipha

The template computes the statistics for left, right and two-tailed tests.
From Hj, our test is right-tailed. Thus the critical value is 1.833114, and
the p value is 0.0084. As p is less than alpha, we reject the null
hypothesis, and can conclude that the mean GPA is greater than 2.5.
(Alternatively, because the # for the test data is 2.9277 which is to the
right of 1.833114, we reject the null hypothesis.)

Note that you can make this more readable, by deleting the parts of the
template (here the Left-tail and Two-Tail tests) that you don’t need.
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Hypothesis Test for Mean
Data Summary
n 10
Mean 29
StdDev 0.43204938
User Input
Hp Mean 25
Alpha 0.05
Computed Val
df 9
t 2.927700219
Left-Tail Test
Left Critical t -1.833113856
p-value 0.991590098
Right-tail Test
Right Critical t 1.833113856
p-value 0.008409902
Twae-tail Test
Critical 1 2.2621586887
p-value 0.016819804




7. Hypothesis Tests for Two Samples

Several two sample hypothesis tests are built into Exvet comparison of means (dependent and independent
samples) and comparison of variances. Unfortunately the ones for means are only-right tailed tests ot two-
tailed tests, so you need to pick the vatiables catrefully to avoid a left-tailed test. Also, the one for
independent samples assuming unequal variances miscalculates the number of degrees of freedom. The
templates in stazstemplates.xls avoid these problems.

7.1 Comparison of means, dependent samples

Example 9

The Central City Insurance Company is concerned about high estitnates of clean up tite received from Royal
Restorers. A random sample of 15 clean up operations is taken from their records and the estimates given by

Royal and by Continental Cleanup, a tival company, are recorded. The company wishes to test whether
Royal’s estimates atre higher than those of Continental at the 5% significance level.

Job 1 2 3 4 5 6 7 8 9 10 11 12 13 | 14 15

R 76 1102|195 | 13|30 |63 |53 ]|62]22] 48 |11.3]121] 69 | 76 | 84

C 73191 |84 | 15127 ]58]4953)]20|42110]|110]) 62| 67| 75

If py and P denote the population mean estimates for Royal and Continental, the hypotheses are
Hy pg < poand Hp: by > p . These may be re-written as H: b ~p.< 0 and H: p~p.>0

7.1.1 Using Templates

In the dependent case, you do a hypothesis test on the difference
between the values. Proceed as follows:

*  Enter the data and use labels like Royal and Continental in
the first tow to name the data.

* Inanother column enter the label Difference at the top. In
the second cell, enter the formula =Royal-Continental and
fill down. Choose Insert, Name, Define to name the
differences.

*  Now follow the steps from Chapter 6: Paste the template
titled Hypozhesis Test for Mean into the worksheet. Edit the firs
three formulas to refer to the name Difference. Enter O for
H, Mean and 0.05 for Abpha.
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The template should now look like the one at the right.

Since the p value is 1.63 X 107%, which is less than 0.05, we reject the null

hypothesis and conclude that Royal does have longer clean up times.

(Alternately, as the test statistic is 5.997 which is bigger than the tight ctitical ~

value of 1.761, so we would reject the null hypothesis.)

7.1.2 Using Excels built in tool

*  Enter the data and use labels like Royal and Continental in the first

row to name the data.

*  Select the Tooks menu and select Data_Analysis. (If it does not

appear on the Took menu, click on .4dd-ins and put a check beside

Analysis Toolpak and click OK)

*  Select #Test: Paired Two Sample For Means and click OK.

Before you can use this feature, you need to decide which data will be

vatiable 1 and which will be variable 2. As the alternate hypothesis is

Hypothesis Test for Mean
Data Summary
n 15
Mean 0.506666667
StdDev 0.391821145
User Input
Hy Mean 0
Alpha 0.05
Computed Values
df 14
t 5.996636843
Left-Tail Test
Left Critical t -1.76130925
p-value 0.999983632
_|Right-tail Test
Right Critical t 1.76130925
p-value 1.636682E-05
Two-tail Test
Critical t 2.144788596
p-value 3.273B4E-D5

H;: bp—B >0, and Exce/will test H;: b, ~P, > 0, the Royal data will be
vatiable 1 and the Continental data vatiable 2.

*  Enter Rgya/ or A1:A16 into the box beside
Variable 1 and Continental or B1:B16 into the
box below it. Entet 0 fot Hypothesized Mean
Difference: and 0.05 for Ajpha. Put a check in
the Labels box. Finally enter a suttable location
for the output range, and click OK.

From the output below, we come to the same
conclusion as when using the template.

t-Test: Paired Two Sample for Means

t-Test: Paired Two Sample for Means
Royal Continental

Mean 6.846666667 6.24
Variance 10.26552381: B.649714286
Observations 15 15
Pearson Correlation 0.995522509

Hypothesized Mean Difference 0

df 14

t Stat 5.996638843

P(T<=t} one-tail 1.63682E-05

t Critical one-tail 1.76130925

P(T<=t} two-tail 3.27364E-05

t Critical two-tail 2.144788596
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7.2 Comparison of Means, Independent Samples

Thete are two possible cases, depending on whether the variances are equal or unequal. Both can be handled
by the templates in statstemplates.xls. They can also be handled by the Datz_Analysis package in Exce/, but the
number of degrees of freedom in the unequal variance case is wrong.

In this section we look at the equal variance test. The unequal variance case is similar.

Example 10.

A new treatment for a type of leaf eating caterpillar that attacks miniature decorative maple trees is tested. A

sample of 14 trees is obtained; half of these are treated, and the other half are left untreated. One week later
the trees are inspected and the number of caterpillars on each tree is found. The results ate shown below:

Treated 18 43 28 50 16 32 13

Untreated 40 54 26 63 21 37 39

Can we say that the treatment works (fewer caterpillars) at the 5% significance level?

If P, and P, denote the population mean number of caterpillars for treated and untreated trees, the
hypotheses are: Hy: Pp.2 By, and H;: B <. These may be re-written as Hy pp—H;; 2 0 and
H: pp-p.<0

Assuming that the populations are normally distributed and that the variances are equal (check first using
desctiptive statistics), proceed as follows:

*  Enter and name the data as usual.
*  DPaste the template from statstemplates.x/s titled Two independent Samples assuming equal variances into your

wotkbook. In this case thete are 6 formulas that need to be edited to refer to the data, plus O for
Hymean difference and 0.05 for .Ajpha.

Twae indep t Samples
assuming equal variances

Data Summary Sample 1 Sample 2
ni=COUNT(Treated) =COUNT(Untreated)
mean:=AVERAGE(Treated) =AVERAGE{Untreated)
std deviation;=STDEV/(Treated) =STDEV(Untreated)
User Input

Hp mean differencei0
Alphai0.05
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The final output should look like the following: Two

14 P
ing equal variances

Data S y Sample 1 _iSample 2
Since we ate doing a left tail test and the p value is 0.0815 which is n 5 57142; 4;
. . . . mean K
blgger than 0.05, we would fail to re)ect the null hypothe51s, and std deviation! 14.093227: 14.67424
conclude that thete is not enough evidence to show that the treated e
. ser Inp
trees have fewer caterpillars. Hp mean diference o
Alpha 005 B
Computed Values
df 13
-1 486161

7.3 Comparison of Variances Left-Tail Test
Lef Criical 1] -1,762267
p-value; 0.0815151

To do a hypothesis test comparing two vatiances, you need to do an F

: Right-tail Test
test. Ig the last example we as§umed that the variances were equal. Right Criicalt 17855667
Was this a reasonable assumption? pvalue’ 09184649

" TTwo-tail Test
Example 11 Critical t; 2.T788128
p-value: 0.1630303

Test whethet it is reasonable to assume that the variances in example
10 are equal.

We will take the following hypotheses: H; 0,.= 0, and H;: 0. # 0, and use a = 0.05.

e  DPaste the template titled

. . parison of Two Varian
Comparison of Two Variances
into the same wotrksheet as Data Summary Sample 1 Sample 2
th . 1 n:=COUNT{Treated) =COUNT (Untreated)
€ previous example. variance =VAR(Treated) =VAR(Untreated)
User Input
Alphal0.05|

*  Edit the four formulas above, and input 4ppha. The output
is shown at right.

Comparison of Two Variances

Data Summary Sample 1 {Sample 2

C . . . . n 7 7
The test statistic is 0.9224, and the p value is 0.9244, so fail to reject variance! 198.619] 215.9533
the null hypothesis. Thete is not enough evidence to show that the
variances are different, so we can assume that they are equal User Input
€y are equat. Alpha; 0,05
Warning: The assumption that the data is normally distributed is Computed Value
crucial for this test, and should be checked first. F. 0.922379
. . . . Left-Tail Test
Warning. If you use Exve/s built in package, it will only do a right- Left Critical F; 0.233435
tailed test, so you will need to change @ and be sure that vatiable 1 is pvalue; 0.462167
the data with greater variance. Righttail Test

Right Critical F: 4.283862
p-value 0.537813

Two-tail Test
Left Critical F! 0.171829

Right Critical F: 5.819743

26 p-value: 0.924375




8. Confidence Intervals/Hypothesis Tests for Proportions

There are templates in the template workbook which will calculate confidence intervals and do hypothesis
tests for proportions. As with means, you can calculate in terms of a data set (generally preferred), or enter
the summary values. Note that you first need to check that the samples and proportions are large enough to
allow approximation using the normal distribution.

Example 12

When 40 people were sampled about whether they support a ban on smoking in restaurants the following
results were obtained. Find a 95% confidence interval for the proportion in the population that suppotts
such a ban.

Yes, Yes, No, No, Yes, No, No, Yes, No, Yes, Yes, No, Yes, No, Yes, No, Yes, No, Yes, No,

Yes, No, Yes, No, Yes, Yes, Yes, No, Yes, Yes, Yes, Yes, No, Yes, Yes, Yes, No, Yes, Yes, No

*  Put the data into a column, together with a Label in the first row, and use this to name the data.

¢ DPaste the template into the worksheet.

Confidence Interval for Preportion

Data Summary

ni=COUNTA({SmokeBan}-1
=COUNTIF(SmokeBan,"Yes")
p-hati=D8/D7

»

»  Edit the first two formulas to refer to your data and enter the confidence level.

Confidence Interval for Proportion

Data Summary

n 40
X 24
p-hat 0.6
User input
Conf_level 09

Canfidence Interva
Lower Limit:  0.472590198
Upper Limit; 0.727409802

The 90% confidence interval for the population proportion is from 47.2% to 72.8%.
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Example 13

In a sample of 254 male college students, 55 were taking business, while a 68 of a
sample of 261 female college students wete taking business. Test the hypothesis
that the propottion of male college students who take business is the same as the
proportion of female college students. Use a significance level of 0.05.

* In this case we have: Hg p, = p,
and  H;p, #p,

*  Copy the template into your workbook.
*  Enter the summary statistics in the cotrect cells.
As the p value is 0.242, we fail to reject the null hypothesis, and conclude that

there is not enough evidence to show that the proportion of male students taking
business is different from the proportion of female students.
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Two Prop

Data Summary

ni 254
x1 55
A phat 11 316538433
n2 261
X 2 68
p_hat 2 0.260536398
User Input
HOMean_Diff: 1]
Alpha 0.05
Computed Value
z -1.170866397
Lefi-tail Test
Left Critical z -1.644853476
p-value 0.120826293
Right-tail Test
Right Critical 2 1644853476
p-value 0.879173701
Two-tail Test
Critical value 1.959962787
p-value 0.241652698 _




9. Scatter Plots, Correlation and Regression

9.1 Plotting a Scatter Plot
Example 1 (Revisited)
A college advisor wishes to study the relationship between incoming students’ high school averages (HSA’s)

and their first semester college grade point averages (GPA’s). A sample of 10 students is obtained and their
HSA’s and GPA’s are recorded, in the following table.

HSA 70 1 751 78 | 80 | 8 | 82 | 72 | 65 | 68 | 75

GPA |24 12813331 (373025} 23] 28] 31

To visually see the relationship, you need to draw a scatter plot. This is done as follows:
*  Open the workbook with the data. (You may want to copy the data to a clean worksheet.

*  Click on the Chart Wigard on the standard toolbar.

g Source Data

*  Choose XY (Scatter), and then click on Nexz>.

*  In the Chart Source Data dialogue box, the cutsor
should be in the Datz Range box. Use the mouse
to select the column cotresponding to the
horizontal axis (in this case FISA), and then
while holding down the Crrlkey, use the
mouse to select the data corresponding to the
vertical axis (in this case GPA). The box should
look like the one at right::

¢ (Click on Nexr>. :
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*  You are now at the Char? Options dialogue box. Under the Tt/ tab, enter a suitable title, and labels
for the two axes. Under the Legend tab remove the check beside Show Legend. Click on Finish.

You will now need to edit the graph (as you did with histograms in Chapter 3) to make it useful and clear..
The biggest problem is that all the points are in one corner of the graph.

*  Right click on the vertical axis and choose Format Axis.

*  Choose the Saak tab and remove all the checks under_ 4. Then set the minimum to 2 and the
maximum to 4.

*  Take similar steps to minimum and maximum values for the X axis.
*  If necessary adjust the size of the plot by dragging the sizing handles to appropriate positions.

Other formatting options are possible. Your chart should look like the following:

First Semester Results
1 i
. L
x 35 i
o * * * [~
5 3 )
= . . -

5]
25 - -
*

2 v T )
60 70 80 % |

High School Average

9.2 Finding the Correlation

The scatter plot seems to indicate that there is a linear relationship between the high school average and the
first semester gpa. We will find the correlation coefficient and, if it is significant, the linear regression
equation.

*  From the Tools menu, choose Data Analysis. (If it does not appear on the Tooks menu, click on Add-
ins and put a check beside Anafysis Toojpak and click OK)) Then choose Regression. A dialogue box
will open.

*  Enter the X and Y ranges. We want High School Averages to be the independent (X) vatiable, and

Grade Point Average to be the dependent (Y) variable. Enter either the names or ranges in the
input boxes.

*  Check Labels, if you have included the labels in the ranges.
*  Enter the Output Range. (Note that the output will be quite large. Leave lots of room.)

¢ Choose a confidence level, say 95% (& = 0.05)
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9.3 Finding the Regression Line

The coefficients of the regression line are given in the output on the previous page. The intercept (4, or B,)

is in the third table immediately to the right of the word Intercepr, while the slope is in the same table
immediately to the right of the word HS5. 4. Thus the regression equation is:

predictedGPA = -1.465 +0.0582 HSA

To undetstand the rest of the output, you may need to refer to your textbook.

9.4 Plotting the Regression Line
Now we want to add this line to the scatter plot we made in section 9.1. To do this:

*  Click on the plot, and then point the cursor at any point on the graph. Right-click and choose A4dd
Trendline. Make sure Linearis selected and click OK.

\Y
- First Semester Results .-
iy N
- “
35 -
g pr
= & . / §
_ g 3 3
5 /
25 —5
2 T .
80 70 80 %0

P High School Average

7

The line plotted is the regression line calculated above.
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Begression

*  Leave all other squares blank.

ISUMMARY OUTPUT

Regression Statistics
Multipie R} 0.858983
R Square | 0.737851
Adjusted R 0.705083
Standard B 0.23463

Obsewvatio 10
ANOVA

df 58 MS F ignificance F
Regressiot 1) 1.239589: 1.23859: 2251703, 0.001454
Residual 8. 0.44041: 0.055051
Total 9 1.68

Coefficientdandard Ern t Stat | P-value [ower 95%Upper 95% ower 95.0%pper 95.0%
Intercept ¢ -1.46475: 0.8922811: -1.587271 0.151112] -3.59276: 0.663252: -3.58276] 0.663252
HSA 0.058187: 0.012264: 4.745211; 0.001454; 0.029915: 0.086478: 0.029915; 0.086478

This Exve/ tool allows for multiple regression, i.e. deciding whether a variable depends on several other
variables. Thus, under Regression Statistics the correlation is labelled Mau/tiple R. Thus the correlation is 0.8590.
For a sample of size 11 is this significant? See the textbook.

Warning: Exve/ gives the absolute value of the correlation coefficient. It is up to you to determine if it is
positive or negative.
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9.5 Plotting Residuals

To get a plot of the residuals, you just need to put a check mark beside Residnal Plots in the dialogue box we
used to calculate the correlation in section 9.2. The plot is as follows:

HSA Reslidual Plot

Residuals

HSA

Of course the graph needs to be reformatted to look something like:

H H H

b HSA Residual Plot I
0.4 ’
-3 0.2 4 . ¢ *
i 0 L4 t t
S o8 p, * & 9
04 b
- HSA i
H
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10. Chi-Square Tests for Variances and Standard Deviations

Example 15. Find the 95% confidence interval for variance and standard deviation of the HSA data from
example 1.

As before:
*  Open both the template file and the workbook with the data. Copy the Confidence Interval for Variance
and Standard Deviation template from the template file into the wotksheet with the data.

*  Edit the two formulas in the template to change datacc into HS.A (the name of the data).

Confidence Interval for Variance
and Standard Deviation

Data Summary

ni=COUNT(datacc)
Std Deviation:==STDEY(datacc)

{User Input

Conf Level

»  Enter the confidence level (0.95).

The worksheet should now appear as below:

Confidence Interval t"or Variance
and Standard Deviation

Data Summary

n 10
Std Deviation B6.377042157

User Input
Conf Level 0.95

Confidence Interval for Variance
Lower Limit 19.24009242
Upper Limit 135.536042

Confidence Interval for Std Deviation |
Lower Limit 4.386352974
Upper Limit 11.64199476

Thus the 95% confidence interval for the variance is from 19.24 to 135.54 and the one for standard deviation
is from 4.38 to 11.65.
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11. Testing Data For Being Normally Distributed

To petform some calculations you need to know whether data is normally distributed.
Example 16.

Determine whether the following data is hormally distributed:

58,71, 61,73, 65,77, 79, 66, 77, 82, 68, 54, 78, 76, 80, 83, 74, 75, 47

The data first needs to be sorted in ascending order.

»  Type the data into column C of a blank worksheet, with the name Data in C1. Make sure columns

B and D are empty.

*  Highlight the column of data, and Click on Inserz, then Name, then Define. Then click OK.

*  Click on Data (on the Menu Bar), then Sort. A dialogue box will appear.

*  If the right data is highlighted, click on OK. If not, click cancel, highlight the data and repeat.

To create columns A and B:

Type Rank, 1, and 2 into the first three cells of column A. Highlight the 1

and 2, and drag down the lower right corner square to complete the

column.

e In B1, type Zvalue

e In B2 type the formula =NORMSINV(A2/(COUNT(Data)+1))

*  Select B2 and drag down using the corner box to create the

remaining entties in column 2.

Your wotksheet should look like the one at the right..

ank Zyalue Data
1: -1.64485 47
2: -1.28155 54
3: -1.03643 58
4. -0.84162 61
5: -067449 b5
b: -0.5244 66
7 -0.38532 68
8. -0.25335 71
9: -0.12566 73
10} 5.47E-10 74
11} 0.125661 75
12; 0.253347 76
13: 0.385321 77
14 0.5244 77
15: 0.67449 78
16i 0.841621 79
17 1.036433 80
18 1.281552 82
19: 1.644853 83
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To check for normality, create a scatter plot of columns B and C. See section 9. If the data is normally
distributed, the points would be on a straight line.

1 i

1 Normal Probability Plot I~
ar
9 PRR ° ~
e
0
<78
PR 1 65
L 2 0
5 68 -
s
¥ 55
55
* . 45 . . . -
2 15 1 05 0 05 1 15 2 |-

In this case, the graph is not linear, and thus we would conclude the data is not normally disttibuted. (See
your text for further details.)
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12. Presentations

In the previous sections we discussed how tho use Exre/to enter data, create graphics and catry out vatious
statistical tests. The result is often a large worksheet that is too wide and long to print. In addition, the form
of the spreadsheet is not suitable for inclusion in a document. For projects and repotts it is necessaty to use
a word processor to create the text and then copy-and-paste relevant parts of the spreadsheet (charts, data,
results of statistical tests) into this document. (See section 1.)

When writing a repott, bear in mind the following points:

*  Tables of data and plots may be re-sized after being pasted into a repott, by clicking on the object
and dragging the sizing handles. This permits these objects to be atranged side-by-side, ot in
groups, for easy comparison. The frequency tables, tables of statistics and plot for a data set are
often presented side-by-side.

*  When sets of data are to be compared, frequency tables and plots should use the same classes.

At titnes you may want to include the whole of the workbook as an appendix to your document. This
requites you to pay catreful attention to the layout of the workbook as you create it. You may need to provide
captions or titles ot to number charts and tables so that they can be refetred to in the body of your
document. If your workbook is wider than your printer can print, Exce/ will divide it hotizontally and
vertically which could be very confusing to your reader. To avoid this problem, move tables and charts
around as you create them.

What is impottant is that your output is clear and easily read by the audience to whom it is directed.

Appendix 1: Location of Files

The file containing the temnplates is available in the student computer labs, on the Richmond and Sutrey
campuses. Its name is statstemplates.xcls. It will probably be on the M dtive.

Appendix 2: Excel Functions used in Statistics

DESCRIPTIVE STATISTICS
AVERAGE(data) - mean (arithmetic) of the numbers in data
MEDIAN(data) - median of the numbers in data
MODE(data) - mode of the numbers in datz
STDEV (data) - sample standard deviation of the numbers in data
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STDEVP(data) - population standard deviation of the numbets in dazz

MIN(data) - minimum value in deta

MAX(data) - maxitmum value in data

QUARTILE(data,)) - #* quartile of the numbers in data. Warning: Excel® uses a different formula to
calculate the first and third quartile than our textbook does.

CONTINUOUS PROBABILITY DISTRIBUTIONS

NORMSDIST(3) - cumulative standard normal disttibution, i.e. P(Z < )

NORMSINV (prob) - inverse of the standard normal distribution, i.e. # where P(Z < 4) = prob.
This is sometimes denoted g, _ b’ To find critical values use NORMSINV(1
~ alpha)

NORMDIST (x,m#,sigma,true) - cumulative nonstandard normal disttibution

NORMINV (prob,mu,sigma) - inverse of nonstandard distribution

TDIST(z,4f1) - complement of cumulative # distribution with ¢f degrees of freedom for #> 0

only, ie. P(¢ D
TINV(probdf) - the critical value #* which satisfies P(#> #*) = prob/2, sometimes denoted #

df, prob/2"
Note the divided by 2.
CHIDIST(x,4}) - complement of the cumulative ¥ distribution with 4f degrees of freedom , i.e.
2
PQly> )
CHIINV (prob,d) - the critical value X,
Examples:
=NORMSDIST(1) - gives 0.84134474 =P(Z<1)

=NORMSINV(0.95) - gives 1.644853 =z,
=NORMSINV(1-0.1) - gives 1.281550794 = g,

=NORMDIST{(200,150,30,true)-NORMDIST(125,150,30,true)
- gives 0.749881345 = P(125< X <200), if X~N{(150,30)
=2*(1-NORMDIST(165,150,30/SQRT(15),ttue))
- gives .052807373, the P value for a two tailed test when
a sample of size 15 has a mean of 165, when taken from
a population with mean 150 and standard deviation 30

=TDIST(1.524,1) - gives 0.073327823 = P(z,,>1.5)

=TINV(1,24) - gives 1.710882316 =1,, .
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=CHIDIST(15.7,10) - gives 0.108548343 =P()’,>15.7)
=CHIINV(0.025,14) - gives 26.11893491 =x},, 0

DISCRETE PROBABILITY DISTRIBUTIONS

BINOMDIST (3, np,false) - Binomial distribution (P(X = x), where X has binomial distribution with »
trials, and the probability of a success is p)
BINOMDIST (3, np,true) - Cumulative Binomial distribution (P(X < x), where X has binomial
distribution with # trials, and the probability of a success is p)
HYPGEOMDIST(x,#,5,IN) - Hypergeometric distribution (P(X = x), where X is the number of
successes in a sample of size # drawn from a population of size N
containing S successes.)
POISSON(x,m4,false) - Poisson distribution (P(X = x), where X has Poisson distribution with mean
.
POISSON((x,74,true) ) - Cumulative Poisson distribution (P(X < %), where X has Poisson
distribution with mean x.)

Examples:

Suppose that X has binomial distribution with # = 10 and p = 0.2
=BINOMDIST(3,10,0.2,false) - gives 0.201326592 = P(X = 3)
=BINOMDIST(3,10,0.2,true) - gives 0.879126118 = P(X < 3)

Suppose that X has Poisson distribution with g = 4.7
=POISSON(3,4.7 false) - gives 0.15738316 = P(X = 3)
=POISSON(3,4.7,true) - gives 0.30968357 = P(X < 3)

CORRELATION AND REGRESSION

CORREL(ydata,xdata) - Pearson Product Correlation coefficient between the sets of data in ydata
and xdata.

SLOPE(ydata,xdata) - slope of the regression line (line of best fit) when using the data in xdazz to
predict the data in ydata.

INTERCEPT (ydata,xdata) - intercept of the regression line (line of best fit).

MISCELLANEOUS FUNCTIONS

RAND() - gives a random number uniformly distributed between 0 and 1 This can be
combined with other probability distributions for a random number with different
distribtutions.

SUM(data) - gives the total of the numbers in data.
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SUMPRODUCT (xdata,ydata)

Examples

=NORMSINV(RAND()

- multiplies each data value in xdatz by the corresponding value is ydata
and adds up the resulting products. This is useful if you want to find
the expected value of a probability distribution, or when you want to
find the mean of a frequency disttibution.

- gives a random number with standard notrmal disttibution.
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